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MỞ ĐẦU 

 

1. Tính cấp thiết của đề tài 

Cùng với việc tin học hóa trong nghành công nghiệp đóng tàu nói chung, cũng 

như trong lĩnh vực thiết kế tàu thủy nói riêng, là sự ra đời của rất nhiều các phần mềm 

phục vụ thiết kế tàu thủy. Trong đó các phần mềm này được phân ra làm hai nhóm, 

nhóm phần mềm thiết kế kỹ thuật và nhóm phần mềm thiết kế công nghệ. Nhóm phần 

mềm thiết kế kỹ thuật gồm có Tribon – AVEVA, NAPA, Autoship, Maxsurf, Freeship, 

Fast ship…. Nhóm phần mềm thiết kế công nghệ gồm có Tribon – AVEVA, Nupas – 

Cadmatic, Shipcontructor…Việc tìm hiểu và sử dụng thành thạo một trong các phần 

mềm này là yêu cầu cần thiết đối với người kĩ sư thiết kế trong lĩnh vực thiết kế tàu 

thủy hiện đại. 

NAPA là  phần mềm thiết kế của Phần Lan, một trong những phần mềm thiết kế 

kỹ thuật đứng đầu thế giới trong lĩnh vực thiết kế tàu thủy. Phần mềm này có thể giải 

quyết hầu hết các bài toán trong giai đoạn thiết kế kỹ thuật. Chính vì vậy nhóm nghiên 

cứu của Viện Khoa học và Công nghệ Hàng hải - Trường Đại học Hàng hải đã thực 

hiện đề tài “ Nghiên cứu xây dựng bài toán tính năng của tàu bằng phần mềm 

NAPA” nhằm mục đích tìm hiểu, Sử dụng phần mềm NAPA để thiết kế tàu thủy trong 

Viện, nhằm nâng cao năng suất lao động và chất lượng sản phẩm.   

2. Mục đích của đề tài 

Từ tài liệu “hướng dẫn sử dụng phần mềm” và một số tài liệu trên internet, đề tài 

đã tìm hiểu được các chức năng của phần mềm NAPA, từ đó nghiên cứu xây dựng bài 

toán tính năng của tàu bằng phần mềm NAPA.  

3. Đối tượng và phạm vi nghiên cứu 

Đối tượng nghiên cứu ở đây là phần mềm NAPA, đề tài tập trung tìm hiểu các 

bước để nghiên cứu xây dựng bài toán tính năng của tàu do Viện Khoa học và Công 

nghệ Hàng hải thiết kế. 

4. Phương pháp nghiên cứu 

Dựa trên việc đọc và phân tích tài liệu “hướng dẫn sử dụng của phần mềm” và 

các tài liệu trên internet. 
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5. Ý nghĩa khoa học và thực tiễn của đề tài 

Ý nghĩa khoa học: 

Đề tài đã đưa ra được các bước nghiên cứu xây dựng bài toán tính năng của tàu 

bằng phần mềm NAPA. 

Ý nghĩa thực tiễn: 

Kết quả nghiên cứu của đề tài nhằm nâng cao năng suất lao động và chất lượng 

sản phẩm và làm tài liệu học tập, tham khảo cho các cán bộ, giảng viên, sinh viên 

ngành thiết kế và đóng tàu trong việc tìm hiểu, nắm bắt phần mềm NAPA. 

6. Kết cấu của đề tài 

Ngoài phần mở đầu, đề tài được chia làm 4 chương: 

Chương 1: Tổng quan 

Chương 2: Chức năng các hệ thống của NAPA 

Chương 3: Các bước xây dựng bài toán tính năng của tàu 

Chương 4: Ứng dụng xây dựng bài toán tính năng tàu tàu kéo 2000CV do Viện 

Khoa học và Công nghệ Hàng hải đã thiết kế. 

Kết luận và kiến nghị 
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CHƯƠNG I: TỔNG QUAN 

 

1.1. Tình hình nghiên cứu trong nước và thế giới 

1.1.1. Tình hình nghiên cứu trong nước 

Hiện nay trong nước đã có một số cơ quan thiết kế, đơn vị thi công đã sử dụng 

phần mềm NAPA nhưng chưa thống nhất và tổng hợp được về cách xây dựng bài toán 

tính năng của tàu. 

1.1.2. Tình hình nghiên cứu trên thế giới 

Phần mềm NAPA hiện nay được rất nhiều nước sử dụng. Theo thống kê của 

hãng bán phần mềm NAPA thì đang có trên 40 nước sử dụng phần mềm này và còn 

mở rộng trong tương lai. 

1.2. Ứng dụng của đề tài 

Kết quả nghiên cứu của đề tài sẽ được ứng dụng trong thiết kế, để nâng cao năng 

suất và độ tin cậy trong tính toán tính năng của tàu được thiết kế bởi Viện Khoa học và 

Công nghệ Hàng hải. Có thể làm tài liệu học tập, tham khảo cho các cán bộ, giảng 

viên, sinh viên nghành thiết kế và đóng tàu trong việc tìm hiểu, nắm bắt phần mềm 

NAPA. 
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CHƯƠNG II: CHỨC NĂNG CÁC HỆ THỐNG CỦA NAPA 

 

2.1. Các hệ thống của phần mềm NAPA 

Phần mềm NAPA được chia ra thành các hệ thống (subsystems) với các chức 

năng khác nhau. Mục đích của việc phân chia này là để người sử dụng làm việc dễ 

dàng hơn và người phát triển hệ thống điều khiển được các hệ thống phức tạp này. 

Các hệ thống của NAPA bao gồm các hệ thống ứng dụng và các hệ thống phụ. 

Ngoài ra còn có một vài chức năng phục vụ chung không được phân chia thành hệ 

thống. 

Các hệ thống ứng dụng thực hiện các nhiệm vụ khác nhau như xây dựng tuyến 

hình, bố trí chung, tính toán các tính năng… nhưng chúng liên quan mật thiết với 

nhau. 

Các hệ thống phụ có nhiệm vụ chính là quản lý các chức năng bên trong của hệ 

thống như quản lý dữ liệu, hình ảnh, tính toán; hầu hết chúng không hiển thị với người 

sử dụng. Tuy nhiên có một số hệ thống phụ cần thiết cho người sử dụng để quản lý dự 

án, quản lý cơ sở dữ liệu, định hình hệ thống… 

Các hệ thống của NAPA sử dụng chung một cơ sở dữ liệu, ta có thể di chuyển từ 

hệ thống này sang hệ thống khác mà không gặp bất kỳ sự cản trở nào. Cơ sở dữ liệu 

này là cơ sở dữ liệu động, nghĩa là khi ta thay đổi bất kỳ một thông số nào thì các 

thông số liên quan sẽ tự động thay đổi theo. 

Các chức năng của các hệ thống được thể hiện qua các nhiệm vụ (tasks), không 

có sự phân biệt rõ ràng giữa hệ thống và nhiệm vụ nhưng nói chung mỗi nhiệm vụ sẽ 

thuộc về một hệ thống nào đó. 

2.2. Danh mục các hệ thống, tên viết tắt và chức năng của chúng 

2.2.1. Hệ thống các ứng dụng 

Ship model SM : Xây dựng bản vẽ bố trí chung 

Geometry GM : Xây dựng tuyến hình, khoang két 

Hydrostatics HD : Tính toán các yếu tố thuỷ tĩnh 

Capacities CP: Tính toán dung tích khoang két 

Loading conditions LD: Thiết lập các trạng thái tải trọng 
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Stability criteria CR: Tính toán ổn định nguyên vẹn 

Damage stability DA: Tính toán ổn định tai nạn 

Launching LN: Tính toán hạ thuỷ 

Inclining INC: phân tích kết quả thử nghiêng lệch 

Weight calculation WG: Tính toán trọng lượng 

Grain stability GS:  Tính toán ảnh hưởng của hàng rời đến ổn định 

Container loading CL: Tính toán sắp xếp container 

Ship hydrodynamics SH: Tính toán thủy động lực học 

Seakeeping SHS: Tính toán tính đi biển 

Manoeuving SHM:  Tính toán tính điều động 

Information system IS:Hệ thống thông tin 

NAPA Steel ST: Xây dựng mô hình kết cấu 

2.2.2. Các hệ thống phụ 

- Monitor (execution and control) MN: Quản lý dự án 

- Database management DB: Quản lý cơ sở dữ liệu 

- Dynamic memory management DM: Quản lý bộ nhớ lưu trữ động 

- Basic geometry GB: hình học cơ bản 

- Integrals IN: Tích phân số 

- Alphanumeric input AI: Quản lý các thông tin đầu vào  

- Alphanumeric output AP: Quản lý các thông tin đầu ra 

- Graphics GR: quản lý hình ảnh 

- Error handling ER: báo lỗi 

- Various functions AD: Lưu trữ các thông tin của dự án tồn tại 

- User interface UI: quản lý giao diện 

2.2.3. Các chức năng phục vụ chung 

- Text editor: Bộ soạn thảo câu lệnh 

- Documentation system: Hệ thống tài liệu 

- Calculator: Máy tính 

- Table calculation: Các bảng tính 
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- Diagram drawing: Các đồ thị 

Hình ảnh sau đây biểu diễn các hệ thống và nhiệm vụ của các hệ thống: 

 

 

Hình 1. Các hệ thống của phần mềm NAPA 

2.3. Giao diện người sử dụng 

2.3.1. Cửa sổ chính 

Giao diện người sử dụng trong NAPA là sự kết hợp giữa giao diện ngôn ngữ lệnh 

(CLI) và giao diện đồ họa (GUI), một vài nhiệm vụ cơ bản của các hệ thống có thể sử 

dụng GUI. Nhưng tất cả các hệ thống đều có thể sử dụng CLI, điều này cho phép tối 

ưu các nhóm lệnh một cách hiệu quả nhất, đây là cách hay được sử dụng nhất. 
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Hình 2. Giao diện cửa sổ chính 

Thanh menu: sử dụng để truy cập vào các nhiệm vụ của các hệ thống, ta cũng có 

thể sử dụng lệnh thay cho việc làm này. 

Thanh công cụ: mở dự án và các phiên bản của dự án. 

Vùng đồ họa tích hợp: vùng hiện thị các hình ảnh được tích hợp vào cửa sổ 

chính, vùng này có thể dùng để hiển thị bất kỳ hình ảnh nào nếu được kích hoạt. 

Vùng nhập lệnh: nơi các lệnh sẽ được nhập từ bàn phím. 

Thanh trạng thái: đưa thông tin về trạng thái của các hệ thống, thông tin cho 

người dùng biết cái gì sẽ xảy ra nếu một nút lệnh được click. 

2.3.2. Cách nhập lệnh 

Cấu trúc chung: Tên lệnh         thông số lệnh 

Một lệnh có thể có một vài thông số hoặc không có bất kỳ thông số nào. 

Vùng đồ họa tích hợp 

Vùng nhập lệnh 

Thanh menu 

Thanh công cụ 

Thanh tiêu đề 

Thanh trạng thái 
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Ví dụ: 

lệnh tạo đường cong qua các điểm: 

Curve (0,0,0) (3,2,4) (4,2,5) 

Lệnh xuất các đường bao tuyến hình tàu: 

Plot HULL 

Tên lệnh không phân biệt chữ hoa và chữ thường 

2.3.3. Nhập lệnh qua công cụ Text Editor 

 

Hình 3. Giao diện Text Editor 

Có thể nhập lệnh trực tiếp từ của sổ chính của phần mềm nhưng có một cách tiện 

lợi hơn là nhập lệnh qua công cụ text editor. Hầu hết thời gian làm việc với NAPA 

chúng ta sẽ sử dụng công cụ text editor để nhập lệnh. Công cụ này cho phép tạo và 

chỉnh sửa các lệnh, các nhóm lệnh và lưu giữ chúng dưới dạng file text. 

Để mở công cụ text editor ta theo đường dẫn sau: Tools - Text Editor 
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CHƯƠNG III: CÁC BƯỚC XÂY DỰNG BÀI TOÁN TÍNH NĂNG  

CỦA TÀU BẰNG PHẦN MỀM NAPA 

 

Màn hình chính khi khởi động phần mềm NAPA  

 

 

 

 

 

 

 

 

 

 

 

 

 



  

11 

3.1. Tạo một project mới 

Chọn File menu từ thanh công cụ sau đó chọn New Project  

 

Sau khi New Project được lựa chọn , một cửa sổ mới sẽ hiện ra bao gồm các thông tin 

ban đầu của tàu như Name (tên project) , giới thiệu chung về Project (Descriptive Text box) , 

Trong phần References Dimensions là các kích thước chính của tàu như Lpp ( chiều dài 2 

đường vuông góc ) , Bdwl (chiểu rộng tàu ) , Tdwl ( chiều chìm thiết kế )  , frame spacing dX 

( khoảng sườn thực ) 
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3.2. Các bước tạo tuyên hình tàu 

Trong phần này sẽ đề cập tới cách thức để tạo tuyến hình tàu , tất cả các câu lệnh để 

định nghĩa đều nằm trong nhóm lệnh DEF  

Cú pháp :  

TASK?>DEF  

Giới thiệu chung 

 Vỏ tàu được định nghĩa bằng cách sử dụng công cụ Hull Surface Editor 

Trong ví dụ này ta sẽ sử dụng công cụ đó để làm phần Mũi tàu (fore ship) – phần đuôi 

tàu làm tương tự 

Định nghĩa thân tàu 

Từ cửa sổ chính : Tools > Hull Surface Editor.  

File > New from template  

Chọn HULLF//NAPADB - Just edge curves is chosen. 
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Bước 1. Mẫu để tạo phần Mũi tàu 

Bảng nhập thông số ban đầu sẽ hiển thị :  

@xfrf=... X-coordinate of forward end of parallel mid body : Vị trí sườn giữa 

@x=... Lenght between perpendiculars:  Khoảng cách Lpp 

@y=... Beam of ship: Chiều rộng tàu 

@z=... Design draught: Chiều chìm 

@br=... Bilge radius: bán kính cong hông 

@zdeck... Height of deck: chiều cao mạn 

Sau khi các thông sô được đã được nhâp thì các đường chính của mũi tàu được hiển thị 
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Bước 2. Các đường chính của HULLF 

Bây giờ ta tiến hành chỉnh sửa các đường này và thêm bớt các đường cần thiết nhằm tạo 

ra mũi tàu theo yêu cầu 
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Cuối cùng sau khi thêm các đường cần thiết ta được  
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Kiểm tra cong trơn tuyến hình 

Sau khi tạo xong phần mũi , ta kiểm tra độ cong trơn của tuyến hình xem đã đạt yêu cầu 

chưa bằng cách sử dụng các công cụ được đánh dấu 1 ,2 ,3, 4, 5, 6 theo hình sau : 

 

Dưới đây là cách thể hiện tính chất cong trơn của tuyến hình theo màu sắc  

 

Ta tiến hành  các bước tương tự để tạo nốt những phần còn lại của thân tàu. 
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3.3. Xây dựng khoang két 

Định nghĩa khoang két 

Một khoang két trong NAPA (được gọi tắt là ROOM ) được định nghĩa đơn 

giản là những không gian , được giới hạn bởi các mặt theo hướng X, Y, Z 

Những Room phức tạp sẽ được tạo thành bằng cách kết hợp 

những ROOM đơn giản 

 

 

 

1. x> (x-min)  

2. x< (x-max)  

3. y> (y-min) 

4. y< (y-max)  

5. z> (z-min)  

6. z< (z-max) 

 Ví dụ: 

Room  Khoang mui 

  LIM   x>5, x<1 y>2, y<hull, z>ttop, z<deck 

Hoặc đơn giản hơn như sau: 

LIM   5, 10, 2, hull, ttop, deck 
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3.3.1. Nhóm các khoang két thành một nhóm: 

Nhập lệnh : Def > Sm 

New a 

Sel type=R 

Add list() 

Save  
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Sau đó từ Menu > Tool > Table Editor               

 

 

Trong Table Editor là danh sách các két đã được tạo ở trên với các thuộc tính như 

Name (tên ký hiệu két) , PURP (loại két) , DES (tên gọi két) …. 

Ở phần PURP thể hiện tính chất của các loại két như 

DO : dầu DO 

FO : dầu FO 

ACC : accommodation : thượng tầng 

MMA : buồng máy  

MST : khoang máy lái 

VOID : khoang trống  

BW : két dằn … 
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3.3.2. Thiết lập bố trí chung khoang két 

Bố trí chung khoang két (setup editor) được thể hiện trong phần Ship Model  

 

Các bước thiết lập : 

1. Mở setup editor  

2. Chọn tab Plans 

3. Mở Plans tab 
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4. Chọn hướng chiếu (x, y hoặc z) 

5. Nhập giá trị trong ô coordinate  

6. Ấn chọn New Plan trên thanh công cụ phía trái. 

7. Lựa chọn tùy biến trong Options tab 

8. Lưu lại setup 
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3.4. Tính toán cân bằng ổn định tàu 

3.4.1.Tạo mặt hứng gió: 

DEF?>gen profile arr*a/y=0.01 

 

 

Hoặc : 

    DEF?>room total 'Whole ship 

R?>lim - - 0 

hull - 7.1 >tunnel 

R?>sym 

R?>add  

r01031 

R?>add  

r01041 

R?>add  ….. 

                 R?>ok 

DEF?>gen profile total/y=0 

 

 

 

3.4.2. Tạo vị trí điểm vào nước: 

Điểm vào nước được sử dụng để xác định góc vào nước  , được viết như sau:  

OPENING name 'descr. text'; 

TYPE type;   
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POS (x,y,z);   

CONN conn; 

OK;   

Trong đó 

Name : tên gọi điểm vào nước 

Type : tính chất điểm vào nước, gồm có 3 loại:  

UNPROTECTED : điểm vào nước không được bảo vệ; 

          WEATHERTIGHT : điểm vào nước kín thời tiết; 

          WATERTIGHT : điểm vào nước kín nước. 

          POS (x,y, z);     Vị trí của điểm vào nước.  

Cmp là không gian  ( khoang két) mà điểm vào nước liên kết với nó       

P      (nước ngập vào khoang két đó )  

Ví dụ: 

OPE OP1 'Door to eng.room' 

TYPE WEATHERTIGHT 

POS (25 -4 12) 

CONNECT R100 R202 

3.4.3. Nhập thông số trạng thái tàu không 

Cách 1: Cách đơn giản nhất để thiết lập thông số tàu không là đưa vào trọng 

lượng tàu không và vị trí tọa độ trọng tâm của nó 

Ví dụ : 

LD?>lgd 

LGDE?>new b 

LGDE?>wei 1100 (trọng lượng tàu không) 

LGDE?>cg 35,0, 4 (tọa độ tàu không) 

LGDE?>save 
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Cách 2 : Nhập thông số tàu không từ bảng biểu các trọng lượng thành phần 

Nhập thông qua bảng biểu ELE*ELEMENTS 

LGDE?>etab p 

created: ELE*ELEMENTS 

Table calculation 

Current table: ELE*ELEMENTS 

ELE?> 

Để sử dụng bảng ta làm như sau: 

Main Window: Tools -> Table editor 

Table Editor: File -> Treat 

Chọn ELE*ELEMENTS 

Sau đó ta có thể tùy chọn thêm bớt , sửa đổi các thành phần trọng lượng tạo nên 

trọng lượng tàu không như hình dưới đây 

 

 

 

3.4.4. Nhập thông số các trạng thái ổn định trong Loading Condition 

Các trạng thái ổn định được định nghĩa trong Loading Conditions – (lệnh LD ).  

Bật màn hình hướng dẫn GUI (graphical user interface)  từ menu TASK  trong cửa sổ 

chính.  
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1. Tạo mới 1 trạng thái tải trọng load case  

2. Mở 1 trạng thái tải trọng đã lưu  

3. Lưu trạng thái tải trọng 

 4. Công cụ Bố trí chung khoang két  

5. Kết quả của trạng thái ổn định đang xét. 

3.4.5. Định nghĩa một trạng thái tải trọng mới 

Một trạng thái tải trọng được tạo mới bằng cách ấn nút New  
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Vùng màu đỏ là tất cả các khoang két của tàu đã được tạo ở phần trước , bằng cách nhấn 

chuột phải vào từng khoang két , sẽ hiện ra menu Edit tank , Fill tank , Empy tank ,Loading 

…. 

ta có thể thêm hoặc bớt khối lượng và các khoang két này sao cho phù hợp với các trạng 

thái tải trọng đang được định nghĩa  

Sau khi tạo được xong một trạng thái tải trọng bằng cách load vào các két, ta sẽ được  
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3.4.6. Nhập các tiêu chuẩn ổn định để kiểm tra ổn định cho tàu 

Dạng chung của một tiêu chuẩn được viết như sau :  

CRI name 'descr. text'; - tên tiêu chuẩn 

TYPE type; - loại tiêu chuẩn 

REQ value; - giá trị yêu cầu của tiêu chuẩn 

RANGE lim1,lim2; - khoảng cách giới hạn 

MOM name; - tên của mô men tác dụng 

OK; 

 

Nội dung của tiêu chuẩn có thể được kiểm tra bằng lệnh DES CRI {criterion}.  

Ví dụ 1 : 

CR_I>des cri area3040 

CRIT, AREA3040, 'Area under GZ curve between 30 and 40 deg' 

TYPE, MINAREA 

REQ, 0.03 

RANG, 30, MIN(40, FA) 
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OK 

Giải thích :  

 Tên tiêu chuẩn : AREA3040 

 Loại tiêu chuẩn là  MINAREA (ví dụ : diện tích nhỏ nhất của diện tích 

dưới đường cong GZ) 

 Giá trị yêu cầu là 0.03 mrad (giá trị nhỏ nhất) 

 Khoảng cách của đường cong GZ giới hạn bởi góc 30 độ tới góc 40 độ 

hoặc góc vào nước (lấy góc nhỏ hơn  

Ví dụ 2: 

 

 

3.4.7. Nhập các tiêu chuẩn ổn định để tính toán : 

CR_I?>args 

ENV INTACT ;** loại ổn định  

RCR  AREA30 AREA40 AREA3040 GZ0.2 MAXGZ25 GM0.15;** các tiêu 

chuẩn 

LOADS LOAD6 ;** tên trạng thái tải trọng 
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HULL STABHULL ;** tên Hull 

T (2.88, 5.28, 0.48) ;** chiều chìm 

TR 0 ;** Độ chúi 

GM 0.15 ;** metacentric height M 

AZI 0 ;** azimuth angle DEGRE 

HEEL 0 10 20 25 30 40 50 60 70 80 ;** heeling angle DEGRE 

ROP ... ;** relevant openings 

RPO ... ;** special points 

CFRB ... ;** freeboard deck edge 

CBILGE ... ;** bilge line 

CMARG ... ;** margin line 

MODE FREE NOSTEP TCG0 AUTO CDISP ;** calculation mode 

RHO 1.025 ;** density TON/M3 

ITOL GM=0.005,M=0.001,DEG=0.1,MRAD=0.0001,RATIO=0.01 

;** iteration tolerance 

NITER 100 ;** number of iterations 

PROF ;** profile curve 

VS 0 ;** service speed M/S 

VF 0 ;** full speed M/S 

NPASS 0 ;** number of passengers 

 

3.4.8. Xuất kết quả ổn định 

Ta sử dụng lệnh sau :  

GET LDX 

LQ  PAR, NAME(F=4), DES(TEXT) MASS(F=6.1), VREL(FILL, F=6.1), 

XM(LCG,F=6.3), YM(TCG,F=6.3), ZM(VCG,F=6.3), FRSM(F=6.2), (LDES), 

(DENS), (LOAD) 

FRSM 'ALL REAL' 

heel 0 5 10 15 20 30 40 50 60 
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LIS PAR NH 

LIS LDD FMT 

LIS FLP 

CR 

RCR  A749-3.1 IMOWEATHER …. Tên các tiêu chuẩn ổn định 

LIST 

 

THÔNG TIN VỀ ỔN ĐỊNH VÀ LỰC NỔI 

  

FLOATING POSITION / calculation method: free trim 

_____________________________________________________________________ 

 

Displacement                   272.55 t    Density          1.025 

t/m3 

Keel thickness                 0.010 m 

  

Draught fore (below keel)       2.25 m      

Draught aft  (below keel)       2.64 m      

Mean draught (below keel)       2.45 m    Trim             -0.38 m 

  

KM above the moulded base       4.56 m 

KG0 (solid)                     2.83 m    GM0 (solid)       1.72 m 

Free surface correction         0.07 m                     -0.07 m 

KG  (fluid)                     2.90 m    GM  (fluid)       1.66 m 

 

 

THÔNG TIN VỀ KÉT 

-------------------------------------------------------------------

----------- 

NAME          DES                      MASS   FILL    LCG    TCG    

VCG   FRSM 

                                          t      %      m      m      

m     tm 
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-------------------------------------------------------------------

----------- 

  

CONTENTS=Diesel Oil (RHO=0.86) 

  

KDAU1.P       ket dau 1 phai           0.78   10.0   4.88  -2.94   

1.97    0.9 

KDAU1.T       ket dau 1 trai           0.78   10.0   4.88   2.94   

1.97    0.9 

KDAU2.P       ket dau 2 phai           0.91   10.0  14.58  -0.61   

0.23   12.5 

KDAU2.T       ket dau 2 trai           0.91   10.0  14.58   0.61   

0.23   12.5 

-------------------------------------------------------------------

----------- 

SUBTOTAL                               3.38         10.10   0.00   

1.04   26.7 

 

  

CONTENTS=Fresh Water (RHO=1) 

  

NN.P          ket nuoc ngot phai       1.00   10.0  18.67  -0.48   

0.38    7.8 

NN.T          ket nuoc ngot trai       1.00   10.0  18.67   0.48   

0.38    7.8 

-------------------------------------------------------------------

----------- 

SUBTOTAL                               2.00         18.67   0.00   

0.38   15.6 

  

  

CONTENTS=Lubricating Oil (RHO=0.9) 

  

LO.P          ket lo tuan hoan phai    0.21   10.0  10.82  -1.92   

0.33    0.1 

LO.T          ket lo tuan hoan trai    0.21   10.0  10.82   1.92   

0.33    0.1 
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-------------------------------------------------------------------

----------- 

SUBTOTAL                               0.42         10.82   0.00   

0.33    0.2 

  

CONTENTS=Miscellaneous (RHO=1) 

  

KGN           ket giu nuoc '           2.95   90.0  11.00   0.00   

0.57    2.8 

  

CONTENTS=Sludge (RHO=2.38) 

  

KDB           ket dau ban             10.62   90.0  12.25   0.00   

0.57   10.3 

  

CONTENTS= (RHO=1) 

  

LTTP                                   0.08    0.0  13.85   0.00   

4.70    0.0 

  

CONTENTS= (RHO=1) 

  

THUYEN VIEN                            0.80    0.0  18.85   0.00   

5.40    0.0 

-------------------------------------------------------------------

----------- 

TOTAL                                 20.25         12.58   0.00   

0.83   55.7 

 

TÀU KHÔNG VÀ TẢI TRỌNG  

 

Lightweight  252.3          12.83   0.00   3.19 

Deadweight  20.25          12.58   0.00   0.83 

Total weight 272.55         12.81   0.00   3.01 
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3.4.9. Kiểm tra ổn định theo các tiêu chuẩn 

Loading condition: LDX 

------------------------------------------------------------------ 

RCR              TEXT                      REQ    ATTV UNIT  STAT       

------------------------------------------------------------------ 

V.AREA30.C       Area under GZ curve .   0.152   0.213 mrad  OK        

V.AREA40.C       Area under GZ curve .   0.270   0.401 mrad  OK        

V.AREA3040.C     Area under GZ curve .   0.101   0.188 mrad  OK        

V.MINGZ30.C      Min. GZ at 30 degr o.   0.558   1.160 m     OK        

V.MINGZ.C        Min. GZ overall         0.710   1.160 m     OK        

V.AREATOT.C      Area under GZ curve .   0.490   0.552 mrad  OK        

AREA30           Area under GZ curve .   0.055   0.213 mrad  OK        

AREA40           Area under GZ curve .   0.090   0.401 mrad  OK        

AREA3040         Area under GZ curve .   0.030   0.188 mrad  OK        

GZ0.2            Max GZ > 0.2            0.200   1.160 m     OK        

MAXGZ25          Max. GZ at an angle .  25.000  39.348 deg   OK        

GM0.15           GM > 0.15 m             0.150   1.279 m     OK        

IMOWEATHER       IMO weather criterion   1.000   5.517       OK        

 

Ta có thể xem các tiêu chuẩn thông qua đồ thị 
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CHƯƠNG IV. ỨNG DỤNG XÂY DỰNG BÀI TOÁN TÍNH NĂNG 

4.1. Tính toán ổn định cho tàu kéo biển công suất 2000CV  

 

 

 

Thông số chủ yếu của tàu: 

Chiều dài lớn nhất ................................. Lmax = 30.0  m 

Chiều dài thiết kế ................................. LTK = 27.61  m 

Chiều rộng tàu ..................................... B = 8.20   m 

Chiều cao mạn ...................................... D = 4.00   m 

Chiều chìm tàu ..................................... d = 2.80   m 

Thuyền viên ..................................... 8     người 

Lượng chiếm nước ................................... Disp = 337.44 t 
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Khối lượng và trọng tâm tàu không:  

 

Khối lượng tàu không .....................................    252.3 t 

Hoành độ trọng tâm .......................................    12.83 m 

Cao độ trọng tâm .........................................     3.19 m 

 

Tiêu chuẩn ổn định nguyên vẹn: 

Tàu được yêu cầu tuân theo nghị quyết IMO A.749(18), bất kỳ trạng thái đi biển 

nào cũng phải tuân theo tiêu chuẩn ổn định nhỏ nhất sau: 

A.  Diện tích dưới đường cong tay đòn ổn định tới góc 30 độ không được nhỏ 

hơn 0.055 mét radian - V.AREA30 

B.  Diện tích dưới đường cong tay đòn ổn định tới góc X độ không được nhỏ 

hơn 0.09 mét radian - V.AREA40                 

C.  Diện tích giữa góc 30 độ và góc X độ không được nhỏ hơn 0.03 mét radian - 

V.AREA3040 

Lấy góc nào nhỏ hơn giữa góc X 40 độ hoặc bất kỳ góc nhỏ hơn nào mà tại đó mép 

thấp hơn của bất kỳ lỗ khoét nào trên vỏ tàu, thượng tầng hoặc lầu không thể đóng kín 

thời tiết, sẽ bị ngập nước. 

D.  Tay đòn ổn định tĩnh lớn nhất GZ không được nhỏ hơn 0.25 m tại góc 

nghiêng bằng hoặc lớn hơn góc 30 độ - V.GZ0.25 

E.  Cánh tay đòn lớn nhất GZ nên đạt ở góc nghiêng lớn hơn 30 độ nhưng 

không được nhỏ hơn 25 độ - V.MAXGZ30 

F.  Chiều cao tâm nghiêng ban đầu GM không được nhỏ hơn 0.15 mét - 

V.GM0.15 

G.      Ổn định của tàu theo tiêu chuẩn thời thiết  K > 1 
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Bước 1: 

Lập Project mới trong phần mềm NAPA 

Từ Menu File > New Project 

Điền các thông số chính của tàu 
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Tạo tuyền hình phần mũi của tàu: 

Vào Hull surface Editor trong menu Tools để tạo tuyến hình mũi 

 

Thêm bớt các đường cần thiết để tạo cong trơn tuyến hình 

 

Tạo tuyến hình phần đuôi của tàu: 
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Sau khi tạo xong  2 phần đuôi mũi rồi ghép lại ta được phần thân chính là Hull 

như sau:  

 

 

Kiểm tra cong trơn tuyến hình: 
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Tạo các khoang két và nhóm lại:  

Sử dụng lệnh ROOM và Limit để tạo các khoang két như sau : 

 

ROOM ACC1 

LIM T1, T2, 0, 2.9, DECK, 7.2 

SYM 

 

ROOM ACC2 

LIM 13, 17.5, 0, 2, 7.2, 9 

ADD T3, T4, 0, 2, 9, 10.65 

SYM 

 

ROOM FUNEL 

LIM T5, 11.75, 0, 0.5, 7.2, 10.05 

 

SUR,  HULL 
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COM HULLA, HULLF 

 

ROOM ACC3 

LIM #35, #48, 0, HULL, 2, DECK 

SYM 

 

ROOM DL.T 'ket dan lai trai' 

LIM -, #-2, 0, HULL, -, DECK 

 

ROOM K.ML 'khoang may lai' 

LIM #-2, #5, 0, HULL, -, DECK 

SYM 

 

ROOM KDAU1.T 'ket dau 1 trai' 

LIM #5, #11, 2.4, HULL, -, DECK 

 

ROOM KDAU2.T 'ket dau 2 trai' 

LIM #26, #33, 0, HULL, -, 1.3 

 

ROOM KDB 'ket dau ban' 

LIM #23, #26, 0, 1.63, HULL, 1.13 

SYM 

 

ROOM KGN 'ket giu nuoc ' ' 

LIM #21, #23, 0, 1.63, HULL, 1.14 

SYM 

 

ROOM KHO 'kho' 

LIM #5, #10, 0, 2.4, HULL, DECK 
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SYM 

 

ROOM KMUI 'khoang mui' 

LIM #50, -, 0, HULL, -, DECK 

SYM 

 

ROOM KTRONG1 'ket trong 1' 

LIM #33, #35, 0, HULL, -, 1.3 

SYM 

 

ROOM KTRONG2 'ket trong 2' 

LIM #48, #50, 0, HULL, -, DECK 

RED XN.T 

SYM 

 

ROOM LO.T 'ket lo tuan hoan trai' 

LIM #17, #25, 1.63, 2.37, HULL, 1.1 

 

ROOM NN.T 'ket nuoc ngot trai' 

LIM #35, #40, 0, HULL, -, 2 

 

ROOM XN 'xich neo' 

LIM #48, #50, 0, HULL, 2, DECK 

SYM 

 

ROOM DANMUI 'ket dan mui trai' 

LIM #40, #48, 0, HULL, -, 2 

SYM 
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ROOM BM 'buong may' 

LIM #5, #35, 0, HULL, -, DECK 

RED KDAU1.T 

RED LO.T 

RED #25, #26, 1.63, 3.17, HULL, 1.3 

SYM 

RED KHO 

RED KDB 

RED KGN 

 

ROOM DL.P 'ket dan lai phai' 

REF DL.T 

 

ROOM KDAU1.P 'ket dau 1 phai' 

REF KDAU1.T 

 

ROOM KDAU2.P 'ket dau 2 phai' 

REF KDAU2.T 

 

ROOM LO.P 'ket lo tuan hoan phai' 

REF LO.T 

 

ROOM NN.P 'ket nuoc ngot phai' 

REF NN.T 

 

ROOM ARR*A 

COM  ,ACC1, ACC2, ACC3, BM, DL.P, DL.T, K.ML, KDAU1.P,  

      KDAU1.T, KDAU2.P, KDAU2.T, KDB, KGN, KHO, KMUI,  

      KTRONG1, KTRONG2, LO.P, LO.T, NN.P, NN.T, FUNEL, XN,  
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      DANMUI 

 

DEF>SM 

NEW A 

SEL TYPE=R 

ADD LIST() 

SAVE   

Đặt thuộc tính cho két: 

Từ menu TOOL > Table Editor , chọn nhóm Arr*a ở trên 

 

 

Tùy vào tính chất các khoang két , ta chọn loại khoang két phù hợp trong phần 

PURP như ACC ( thượng tầng ) , BW (két dằn) , MST (khoang máy lái) , Do (dầu 

DO) , Void ( kho – khoang trống ) ,Lo (két dầu LO) , MIS (két nước thải) ,CHA (xich 

neo ) 

Sau đó từ thanh Menu , vào phần Tools , chọn Geometry Editor , ta sẽ có được 

thông tin toàn bộ của các két , ứng với mỗi loại két là từng màu sắc riêng biệt 
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Tạo Bố trí chung khoang két: 

Từ thanh công cụ Menu , vào phần Tool > chọn Set up Editor  

Chọn New Plan và thiết lập các mặt cắt theo các tọa độ X, Y ,Z  
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Tạo mặt hứng gió:  

DEF>GEN PROF ARR*A/Y=0.01 

 

 

 

Tạo vị trí điểm vào nước: 

Điểm vào nước là vị trí cửa thượng tầng  , được viết như sau:  

OPEN, O1, 'cua thuong tang' 

POS,  (#25, 2.9, 4.4) 

TYP,  WEA 

CON,  SEA, ACC2 

OK 

 

Nhập thông số tàu không: 

LD>LGDE 

DIST,LLOY, 0.6 

WEI, 252.3 

CG,  12.830, 0, 3.19 

SAVE 

 

Nhập các tiêu chuẩn ổn định vào để tính toán: 

CR_I?>args 

ENV INTACT ;**  
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RCR  AREA30 AREA40 AREA3040 GZ0.2 MAXGZ25 GM0.15;** các tiêu 

chuẩn 

LOADS LOAD6 ;** tên trạng thái tải trọng 

HULL STABHULL ;** tên Hull 

T (2.88, 5.28, 0.48) ;** chiều chìm 

TR 0 ;** Độ chúi 

GM 0.15 ;** metacentric height M 

AZI 0 ;** azimuth angle DEGRE 

HEEL 0 10 20 25 30 40 50 60 70 80 ;** heeling angle DEGRE 

ROP ... ;** relevant openings 

RPO ... ;** special points 

CFRB ... ;** freeboard deck edge 

CBILGE ... ;** bilge line 

CMARG ... ;** margin line 

MODE FREE NOSTEP TCG0 AUTO CDISP ;** calculation mode 

RHO 1.025 ;** density TON/M3 

ITOL GM=0.005,M=0.001,DEG=0.1,MRAD=0.0001,RATIO=0.01 

;** iteration tolerance 

NITER 100 ;** number of iterations 

PROF ;** profile curve 

VS 0 ;** service speed M/S 

VF 0 ;** full speed M/S 

NPASS 0 ;** number of passengers 

 

Tạo trạng thái tải trọng mới : 

 Ta sẽ tính ở một trạng thái là đầy tải 100% dự trữ , có dằn 

Từ cửa sổ chính Main window , chọn menu Task , Chọn Loading Conditions 
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Khi vào trong Loading Condintions , ta chọn nút New để tạo trạng thái tải trọng 

mới  

 

Lần lượt từng két ta sẽ load thêm vào khối lượng để có được trạng thái đầy tải 



  

49 

 

 

 

Chuyển sang Tab MASS để nhập khối lượng và tọa độ các thành phần khối 

lượng không đổi như khối lượng thuyền viên , khối lượng lương thực – thực phẩm 

Ta có thể kiểm tra nhanh tại trạng thái ổn định đó theo các tiêu chuẩn đưa vào 

xem đã đạt chưa thông qua Tab Criteria nếu đạt sẽ có thông báo là OK , nếu không đạt 

sẽ là NOT MET 
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Kiểm tra nhanh tư thế tàu bằng cách sử dụng Tab Results , sẽ có các thông số 

như Lượng chiếm nước Disp , tọa độ tâm nổi LCB , độ chúi Trim , góc nghiêng HEEL 

, chiều cao tâm nghiêng GM , chiều chìm mũi lái LA , LF 
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Xuất kết quả của trạng thái đầy tải: 

Ta sử dụng lệnh sau :  

GET LDX 

LQ  PAR, NAME(F=4), DES(TEXT) MASS(F=6.1), VREL(FILL, F=6.1), 

XM(LCG,F=6.3), YM(TCG,F=6.3), ZM(VCG,F=6.3), FRSM(F=6.2), (LDES), 

(DENS), (LOAD) 

FRSM 'ALL REAL' 

heel 0 5 10 15 20 30 40 50 60 

LIS PAR NH 

LIS LDD FMT 

LIS FLP 

CR 

RCR  V.AREA30 V.AREA40 V.AREA3040 V.GZ0.2 V.MAXGZ25 V.GM0.15 

IMOWEATHER  

LIST 

 

THÔNG TIN VỀ ỔN ĐỊNH VÀ LỰC NỔI 

FLOATING POSITION / calculation method: free trim 

_____________________________________________________________________ 

 

Displacement                   337.44 t    Density          1.025 

t/m3 

Keel thickness                 0.010 m 

  

Draught fore (below keel)       2.78 m      

Draught aft  (below keel)       2.83 m      

Mean draught (below keel)       2.80 m    Trim             -0.06 m 

  

KM above the moulded base       4.48 m 

KG0 (solid)                     2.83 m    GM0 (solid)       1.66 m 

Free surface correction         0.18 m                     -0.18 m 

KG  (fluid)                     3.01 m    GM  (fluid)       1.48 m 
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SƠ ĐỒ HÌNH DÁNG TÀU: 

 

 

 

THÔNG TIN VỀ DỰ TRỮ VÀ NƯỚC DẰN 

----------------------------------------------------------------------

------------- 

NAME          TEXT                     MASS   FILL    LCG     TCG   

VCG    FRSM 

                                         t     %       m       m     

m      tm 

-------------------------------------------------------------------

------------ 

CONTENTS=Ballast Water (RHO=1.025) 

  

DL.P          ket dan lai phai         4.55  100.0  -1.45  -1.50   

3.54    0.0 
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DL.T          ket dan lai trai         4.55  100.0  -1.45   1.50   

3.54    0.0 

DANMUI        ket dan mui             15.60 80.4   21.69   0.00   

1.16   25.6 

-------------------------------------------------------------------

----------- 

SUBTOTAL                              24.70         13.16   0.00   

2.04   25.6 

  

CONTENTS=Diesel Oil (RHO=0.86) 

  

KDAU1.P       ket dau 1 phai           7.67   98.0   4.16  -3.13   

3.10    0.9 

KDAU1.T       ket dau 1 trai           7.67   98.0   4.16   3.13   

3.10    0.9 

KDAU2.P       ket dau 2 phai           8.91   98.0  14.65  -1.47   

0.80   12.5 

KDAU2.T       ket dau 2 trai           8.91   98.0  14.65   1.47   

0.80   12.5 

-------------------------------------------------------------------

----------- 

SUBTOTAL                              33.14          9.80   0.00   

1.87   26.7 

  

CONTENTS=Fresh Water (RHO=1) 

  

NN.P          ket nuoc ngot phai      10.02  100.0  18.69  -1.28   

1.27    7.8 

NN.T          ket nuoc ngot trai      10.02  100.0  18.69   1.28   

1.27    7.8 

-------------------------------------------------------------------

----------- 

SUBTOTAL                              20.04         18.69   0.00   

1.27   15.6 

  

CONTENTS=Lubricating Oil (RHO=0.9) 
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LO.P          ket lo tuan hoan phai    2.05   98.0  10.54  -1.99   

0.69    0.1 

LO.T          ket lo tuan hoan trai    2.05   98.0  10.54   1.99   

0.69    0.1 

-------------------------------------------------------------------

----------- 

SUBTOTAL                               4.09         10.54   0.00   

0.69    0.2 

  

CONTENTS=Miscellaneous (RHO=1) 

  

KGN           ket giu nuoc '           0.33   10.0  11.01   0.00   

0.15    2.8 

  

CONTENTS=Sludge (RHO=2.38) 

  

KDB           ket dau ban              1.18   10.0  12.24   0.00   

0.15    8.5 

  

CONTENTS= (RHO=1) 

  

LTTP                                   0.80    0.0  13.85   0.00   

4.70    0.0 

-------------------------------------------------------------------

----------- 

NAME          DES                      MASS   FILL    LCG    TCG    

VCG   FRSM 

                                          t      %      m      m      

m     tm 

-------------------------------------------------------------------

----------- 

CONTENTS= (RHO=1) 

  

THUYEN VIEN                            0.80    0.0  18.85   0.00   

5.40    0.0 

-------------------------------------------------------------------

----------- 
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TOTAL                                 85.08         13.07   0.00   

1.75   61.1 

Lightweight  252.3          12.83   0.00   3.19 

Deadweight  85.14          13.07   0.00   1.75 

Total weight      337.44         12.89   0.00   2.83 

 

KIỂM TRA ỔN ĐỊNH TĨNH: 

 

 

 

 

 

ỔN ĐỊNH TĨNH CỦA TÀU THEO CÁC QUY ĐỊNH LIÊN QUAN:  

 

-------------------------------------------------------------------

- 

RCR          TEXT                           REQ    ATTV UNIT   STAT  

-------------------------------------------------------------------

- 

V.AREA30     Area under GZ curve up to.   0.055   0.199 mrad   OK   

V.AREA40     Area under GZ curve up to.   0.090   0.319 mrad   OK   
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V.AREA3040   Area under GZ curve betwe.   0.030   0.120 mrad   OK   

V.GZ0.25     Min. GZ > 0.25               0.200   0.693 m      OK   

V.MAXGZ30    Max. GZ at an angle > 30 .   30.000  34.078deg    OK   

V.GM0.15     GM > 0.15 m                  0.150   1.476 m      OK   

IMOWEATHER   IMO weather criterion        1.000   2.009        OK   

-------------------------------------------------------------------

- 

 

4.2. So sánh ưu nhược điểm với phần mềm Autoship 

1.Ưu điểm: 

-Sử dụng phần mềm NAPA để tính ổn định sẽ trực quan và rõ ràng hơn khi sử 

dụng phần mềm Autoship ví có công cụ riêng đó là Loading Conditions , các khoang 

két được hiển thị bằng màu sắc với từng nhóm riêng biệt , có thể kiểm tra nhanh được 

tư thế và kiểm tra nhanh được xem tàu có đủ ổn định theo các tiêu chuẩn đề ra hay 

không ngay trên cửa sổ công cụ Loading Conditions từ đó ta có thể nhanh chóng thay 

đổi phương án Loading vào các khoang két trên tàu 

2. Nhược điểm: 

Phải qua nhiều bước mới có thể tính và kiểm tra được ổn định và tư thế tàu trong 

khi đó khi sử dụng phần mềm Autoship chỉ cần nhập tuyến hình vào phần mềm , tạo 

khoang két và sử dụng công cụ text editor và nhập các lệnh đơn giản bên trong là có 

thể tính ngay ra được. 
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KẾT LUẬN VÀ KIẾN NGHỊ 

1. Kết luận 

Sau thời gian nghiên cứu, dưới sự cố gắng của nhóm nghiên cứu và được sự giúp 

đỡ tận của đồng nghiệp nhóm đã hoàn thành đề tài “ Nghiên cứu xây dựng bài toán 

tính năng của tàu bằng phần mềm NAPA”. 

Trên cơ sở nghiên cứu tài liệu “hướng dẫn sử dụng phần mềm”  và một số tài liệu 

trên internet, đề tài đã đưa ra được các bước tính toán tính năng của tàu bằng phần 

mềm NAPA. Để nâng cao hiệu quả áp dụng của đề tài, trong quá trình công tác nhóm 

tác giả phải thường sử dụng phần mềm và áp dụng tính toán tính năng cho các loại tàu 

khác nhau để đề tài ngày càng phong phú và đa dạng. 

2. Kiến nghị 

Đề tài này mới chỉ nghiên cứu module xây dựng tuyến hình và module tính năng 

của tàu bằng phần mềm NAPA. Do đó để tiếp tục nghiên cứu phát triển đề tài, nhóm 

nghiên cứu sẽ tìm hiểu các module khác của phần mềm và sẽ kiến nghị với Trường 

Đại học Hàng Hải nói chung và Viện Khoa học và Công nghệ Hàng hải nói riêng cần 

quan tâm, tạo điều kiện hơn nữa. Từ đó nhóm tác giả có thể tìm hiểu đầy đủ về phần 

mềm NAPA phục vụ cho công việc thiết kế và công tác đào tạo. 
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TÀI LIỆU THAM KHẢO 

 

1. Tài liệu hướng dẫn sử dụng của phần mềm NAPA bằng tiếng Anh 

2. Các tài liệu trên trang web http://www.napa.fi/ của NAPA Software 

 

http://www.napa.fi/

